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Configuring an Email Account to Access 
Cisco Unity Connection 8.x Voice Messages

Cisco Unity Connection allows licensed users to use a third-party IMAP client to access voice messages 
from their desktop machines. You can also forward voice messages with text and reply to voice messages 
with text; the text portion of the message is accessible through the Connection text-to-speech feature.

See the following sections:

• Considerations When Configuring IMAP Email Clients in Cisco Unity Connection 8.x, page 3-2

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Apple Mail, 
page 3-2

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Eudora, page 3-4

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in IBM Lotus Notes, 
page 3-5

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Microsoft Outlook, 
page 3-6

• Setting Up ViewMail for Outlook in Cisco Unity Connection 8.x, page 3-9

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Microsoft Outlook 
Express, page 3-11

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Novell GroupWise, 
page 3-13

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Opera, page 3-14

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Thunderbird, 
page 3-16

• Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Windows Mail for 
Windows Vista, page 3-17

• Troubleshooting IMAP Client Sign-In Problems in Cisco Unity Connection 8.x, page 3-18

Note When users change their Cisco Personal Communications Assistant (PCA) password (also known as the 
web-application password) in the Connection Messaging Assistant, they also must update the password 
in their IMAP client application. Passwords are not synchronized between IMAP clients and the 
Cisco PCA. If users have trouble receiving voice messages in an IMAP client even after updating their 
Cisco PCA password in both applications, see the “Troubleshooting IMAP Client Sign-In Problems in 
Cisco Unity Connection 8.x” section on page 3-18.
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Considerations When Configuring IMAP Email Clients in 
Cisco Unity Connection 8.x

Note the following considerations when configuring IMAP email clients to access Cisco Unity 
Connection voice messages:

• In Cisco Unity Connection Administration, configure the following settings on the System 
Settings > SMTP Configuration > Server page to match the SSL settings in the IMAP email clients:

– Allow Connections From Untrusted IP Addresses

– Require Authentication From Untrusted IP Addresses

– Transport Layer Security From Untrusted IP Addresses Is (Disabled, Required, Optional)

For more information on these settings, see the “SMTP Server Configuration” section in the 
“System Settings in Cisco Unity Connection 8.x” chapter of the Interface Reference Guide for 
Cisco Unity Connection Administration Release 8.x, at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/gui_reference/guide/8xcucgrgx.
html.

• IMAP email clients all include two fields in which you can enter either the IP address or the fully 
qualified domain name of the Connection server. When a Connection cluster is configured, enter the 
fully qualified domain name of a DNS A record that includes the Connection publisher and 
subscriber servers. If your DNS server allows you to specify the order in which DNS tries to contact 
Connection servers, specify that the server that is available most often is the first server contacted. 
This usually is the publisher server.

Some IMAP email clients do not respect DNS A records. For those clients, if the first Connection 
server is not available, the client does not try to access the other Connection server.

• When a user forwards or replies to a voice message from an IMAP email client, the message will be 
sent to recipients on the Connection server unless the user specifically configures the message to be 
sent through another account.

See the “Configuring IMAP Settings in Cisco Unity Connection 8.x” chapter of the System 
Administration Guide for Cisco Unity Connection Release 8.x for additional details. The guide is 
available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
l.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Apple Mail

To use Apple Mail to access Cisco Unity Connection voice messages, create and configure a new Apple 
Mail account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.
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To Create and Configure a New Account in Apple Mail

Step 1 Start Apple Mail.

Step 2 In Apple Mail, on the Mail menu, select Preferences.

Step 3 At the top of the Preferences dialog box, select Accounts.

Step 4 In the lower left corner, select +.

Step 5 In the Account Type list, select IMAP.

Step 6 In the Description field, enter a name for the account. This name appears only in Apple Mail.

Step 7 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Full Name field, enter the username.

Step 9 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 In the User Name field, enter the Connection username.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 In the Outgoing Mail Server (SMTP) field, select the IP address or the fully qualified domain name of 
the Connection server.

Step 13 Select Server Settings.

Step 14 Optionally, in the SMTP Server Options dialog box, check the Use Secure Sockets Layer (SSL) check 
box.

Caution If you do not configure Apple Mail to use SSL, the Connection username and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

Step 15 In the Authentication list, select Password.

Step 16 Select OK to close the SMTP Options dialog box.

Step 17 Select the Advanced tab.

Step 18 In the Keep Copies of Messages for Offline Viewing list, select the applicable option.

Step 19 Close the Preferences dialog box.

Step 20 In the Save Changes dialog box, select Save.
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Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Eudora

To use Eudora to access Cisco Unity Connection voice messages, create and configure a new Eudora 
account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Eudora

Step 1 Start Eudora.

Step 2 On the Eudora Tools menu, select Personalities.

Step 3 Right-click anywhere in the Personalities tab, and select New.

Step 4 In the New Account wizard, on the Account Settings page, select Next to accept the default value, Create 
a Brand New E-Mail Account.

Step 5 On the Personality Name page, enter a display name for the account. The value that you enter here is 
visible only in Eudora.

Step 6 Select Next.

Step 7 On the Personal Information page, enter the username.

Step 8 Select Next.

Step 9 On the E-Mail Address page, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 Select Next.

Step 11 On the User Name page, enter the Connection username.

Step 12 Select Next.

Step 13 On the Incoming E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 For the type of server, select IMAP.

Step 15 Select Next.

Step 16 On the IMAP Location Prefix page, do not enter a value.

Step 17 Select Next.

Step 18 On the Outgoing E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.
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Step 19 Select Next.

Step 20 On the Success page, select Finish to create the account and close the wizard.

Step 21 In the Enter Password dialog box, enter the Cisco PCA password of the user.

Step 22 Select OK.

Step 23 Optionally, configure the new account to use SSL. For more information, see Eudora Help.

Caution If you do not configure Eudora to use SSL, the Connection username and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in IBM Lotus Notes

Caution If you plan to configure user accounts to use Cisco Unity Connection ViewMail for IBM Lotus Notes, 
do not follow the instructions in this section. Instead, follow the configuration instructions in the Release 
Notes for Cisco Unity Connection ViewMail for IBM Lotus Notes, available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

To use Notes to access Cisco Unity Connection voice messages, create and configure a new Notes 
account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

Caution When using Lotus Notes version 7.x to access Connection voice messages, you must first configure 
Notes to connect to a Domino account before configuring the Connection account.

To Create and Configure a New Account in IBM Lotus Notes

Step 1 Start IBM Lotus Notes.

Step 2 On the Notes File menu, select Preferences > Client Reconfiguration Wizard.

Step 3 In the Lotus Notes Client Configuration wizard, on the Additional Services page, check the Internet 
Mail Servers (POP or IMAP, SMTP) check box.

Step 4 Select Next.

Step 5 On the Set Up Internet Mail page, in the Select the Type of Server Used for Retrieving Incoming Mail 
list, select IMAP.

Step 6 In the Enter a New Account Name list, select Incoming Internet Mail.
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Step 7 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Cisco Unity Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 Select Next.

Step 9 On the Set Up Internet Mail page, in the Account Name field, enter the Connection SMTP Address of 
the user and the name of the Connection server. You can find this information in the SMTP Address field 
on the User Basics page in Cisco Unity Connection Administration. The Account Name typically 
follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 In the Password fields, enter and confirm the Cisco PCA password of the user.

Step 11 If you want to encrypt voice messages and other data that are sent between Notes and Connection, check 
the Log On Using SSL check box. If not, skip to Step 12.

Caution If you do not configure Notes to use SSL, the Connection username and password that are sent 
to Connection over the network and the voice messages that are sent back from Connection 
are not encrypted.

Step 12 Select Next.

Step 13 On the second Set Up Internet Mail page, in the Enter a New Account Name list, select Outgoing 
Internet Mail.

Step 14 In the Outgoing SMTP Mail Server list, enter the IP address or the fully qualified domain name of the 
Connection server.

Step 15 Select Next.

Step 16 On the third Set Up Internet Mail page, in the E-Mail Address field, enter the Connection alias of the 
user and the name of the Connection server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 17 In the Internet Domain field, enter the Internet domain name of the Domino mail server.

Step 18 Select Next.

Step 19 Select OK.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Microsoft Outlook

Revised November 16, 2010
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Caution If you plan to configure user accounts to use Cisco ViewMail for Microsoft Outlook 8.5 or later, do not 
follow the instructions in this section. Instead, follow the configuration instructions in the applicable 
Release Notes for Cisco ViewMail for Microsoft Outlook, available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

To use Outlook to access Cisco Unity Connection voice messages, create and configure a new Outlook 
account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

In addition to configuring Outlook to access Connection voice messages, you can also install the optional 
ViewMail for Outlook plug-in. See the “Setting Up ViewMail for Outlook in Cisco Unity Connection 
8.x” section on page 3-9.

To Create and Configure a New Account in Outlook

Step 1 Start Outlook.

Step 2 On the Outlook Tools menu, select E-Mail Accounts.

Step 3 In the E-Mail Accounts wizard, select Add a New E-Mail Account.

Step 4 Select Next.

Step 5 On the Server Type page, select IMAP.

Step 6 Select Next.

Step 7 Enter values in the User Information section:

a. In the Your Name field, enter a display name for the account. The value that you enter here is visible 
only in Outlook.

b. In the E-Mail Address field, enter one of the following:

• The Connection SMTP Address of the user and the name of the Connection server. You can find 
this information in the SMTP Address field on the User Basics page in Cisco Unity Connection 
Administration. The E-Mail Address typically follows this format:

<alias>@<SMTP domain name of the Connection server or cluster>

• The proxy address for the user.

Step 8 Enter values in the Server Information Section:

a. In the Incoming Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

b. In the Outgoing Server field, select the IP address or the fully qualified domain name of the 
Connection server.
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Step 9 Enter values in the Logon Information section:

a. In the User Name field, enter the Connection username.

b. In the Password field, enter the Cisco PCA password of the user.

c. Verify that the Remember Password check box is not checked. If this option is checked, and the 
Connection password of the user expires, changes, or is locked, Microsoft Outlook does not prompt 
the user to enter the Connection password. The result is that users do not receive voice messages 
from Connection.

Step 10 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook and Connection, skip to Step 15.

Caution If you do not configure Outlook to use SSL, the Connection username and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook and Connection, 
continue with Step 11.

Step 11 Select More Settings.

Step 12 In the Internet E-Mail Settings dialog box, select the Advanced tab.

Step 13 Under Incoming Server (IMAP), check the This Server Requires an Encrypted Connection (SSL) 
check box.

Step 14 Select OK to close the Internet E-Mail Settings dialog box.

Step 15 If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to 
Step 21.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses, 
continue with Step 16.

Step 16 Select More Settings.

Step 17 In the Internet E-Mail Settings dialog box, select the Outgoing Server tab.

Step 18 Verify that the My Outgoing Server (STMP) Requires Authentication check box is checked.

Step 19 Verify that Use Same Settings as My Incoming Mail is selected.

Step 20 Select OK to close the Internet E-Mail Settings dialog box.

Step 21 Select Next.

Step 22 Select Finish.

Step 23 In the left pane of Outlook, select the Inbox folder for the new account.

Step 24 On the Outlook Tools menu, select Send/Receive > This Folder.

Step 25 If prompted, enter the Connection username and Cisco PCA password.
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Setting Up ViewMail for Outlook in Cisco Unity Connection 8.x

Cisco ViewMail for Microsoft Outlook 8.5 and Later
Added November 16, 2010
To install and set up Cisco ViewMail for Microsoft Outlook 8.5 or later, see the applicable Release Notes 
for Cisco ViewMail for Microsoft Outlook at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

Cisco Unity Connection ViewMail for Microsoft Outlook 8.0
Revised November 16, 2010
By using ViewMail for Outlook 8.0 to access Cisco Unity Connection voice messages, users can play 
and record voice messages by using the Media Master. See Figure 3-1.

Figure 3-1 Media Master

See the following sections:

• Task List for Setting Up ViewMail for Outlook 8.0, page 3-9

• Configuring the IMAP Account for ViewMail for Outlook 8.0, page 3-10

• Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP, page 3-10

Task List for Setting Up ViewMail for Outlook 8.0

Revised November 16, 2010
ViewMail must be installed on each user workstation. Complete the following tasks to set up ViewMail 
8.0 for users:

1. Review the applicable Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook, 
available at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. The 
document specifies the requirements and procedures for installing 8.0.

2. If you have not already done so, install ViewMail 8.0 according to the procedures in the Release 
Notes for Cisco Unity Connection ViewMail for Microsoft Outlook.

3. If you have not already done so, configure an IMAP account in Microsoft Outlook. See the “Creating 
and Configuring an Account to Access Cisco Unity Connection 8.x in Microsoft Outlook” section 
on page 3-6.
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4. If users have more then one IMAP account configured, you must configure ViewMail 8.0 to use the 
IMAP account that is used to access Connection. See the “Configuring the IMAP Account for 
ViewMail for Outlook 8.0” section on page 3-10.

5. If you use secure messaging or TRAP, you must configure several ViewMail 8.0 settings. See the 
“Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP” section on 
page 3-10.

Configuring the IMAP Account for ViewMail for Outlook 8.0

Revised November 16, 2010
If users have more than one IMAP account configured, you must configure ViewMail 8.0 to use the 
IMAP account that is used to access Connection. This ensures that messages composed by using 
ViewMail are sent to the Connection server. If users have only one IMAP account configured, ViewMail 
automatically uses it to send messages to Connection.

Do the following procedure on each user workstation.

To Configure ViewMail for Outlook 8.0 Settings

Step 1 From the Outlook Tools menu, select ViewMail Options.

Step 2 Select the Accounts tab.

Step 3 In the Select the Account to Access Cisco Unity Connection With field, select the IMAP account that is 
used to access Connection.

Step 4 Select Save.

Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP

Revised November 16, 2010
If you have configured Connection for secure messaging or if you want users to be able to record or play 
messages by phone by using Telephone Record and Playback (TRAP), you must configure several 
ViewMail 8.0 settings.

After ViewMail 8.0 has been installed, do the following procedure on each user workstation.

To Configure ViewMail for Outlook 8.0 Secure Message and TRAP Settings

Step 1 From the Outlook Tools menu, select ViewMail Options.

Step 2 Select the Server tab.

Step 3 Enter the following settings:

Table 3-1 Server Settings

Field Setting

Cisco Unity Connection 
Server Name

Enter the name of the Connection server. (Required for secure messaging 
and TRAP.)

Username Enter the Connection username (alias).
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Step 4 Select Save.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Microsoft Outlook Express

To use Outlook Express to access Cisco Unity Connection voice messages, create and configure a new 
Outlook Express account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

Password (Optional) Enter the Cisco PCA password (also known as the 
web-application password) of the user. If you do not enter the password, 
the user is prompted for it each time Outlook is restarted. If you do not 
want the user to be prompted for the password each time Outlook is 
restarted, you must also check the Remember Password check box.

Remember Password (Optional) Check this check box if you want ViewMail to remember the 
user password so that the user does not have to re-enter it each time 
Outlook is restarted.

Proxy Server Address If you have a firewall that blocks HTTPS traffic between user 
workstations and the Connection server, enter the IP address of the 
HTTPS proxy server.

Proxy Server Port If you have a firewall that blocks HTTPS traffic between user 
workstations and the Connection server, enter the server port to use when 
connecting to the HTTPS proxy server.

Validate HTTPS Certificate If you replace the default self-signed certificate with a certificate from a 
certificate authority, check the Validate HTTPS Certificate check box.

If you are using the default certificate installed with Connection, this 
check box must not be checked.

For details, see the “Configuring SSL in Cisco Unity Connection 8.x” 
chapter of the System Administration Guide for Cisco Unity Connection 
Release 8.x, at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/admi
nistration/guide/8xcucsagx.html.

Extension Enter the extension of the user.

This setting is required only if you want the user to be able to record or 
play messages by phone.

Table 3-1 Server Settings (continued)

Field Setting
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To Create and Configure a New Account in Outlook Express

Step 1 Start Outlook Express.

Step 2 On the Outlook Express Tools menu, select Accounts.

Step 3 In the Internet Accounts dialog box, select the Mail tab.

Step 4 Select Add > Mail, and the Internet Connection wizard appears.

Step 5 On the Your Name page, in the Display Name field, enter the username.

Step 6 Select Next.

Step 7 On the Internet E-Mail Address page, select I Already Have an E-Mail Address That I'd Like to Use.

Step 8 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Select Next.

Step 10 On the E-Mail Server Names page, in the My Incoming Mail Server Is a <protocol> Server list, select 
IMAP.

Step 11 In the Incoming Mail (POP3, IMAP, or HTTP) Server field, enter the IP address or the fully qualified 
domain name of the Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 12 In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of 
the Connection server.

Step 13 Select Next.

Step 14 On the Internet Mail Logon page, in the Account Name and Password fields, enter the Connection 
username and Cisco PCA password.

Step 15 Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
Microsoft Outlook Express does not prompt the user to enter the Connection password. The result is that 
users do not receive voice messages from Connection.

Step 16 Select Next.

Step 17 On the Congratulations page, select Finish.

Step 18 In the Internet Accounts dialog box, select the account that you created in Step 4, and select Properties.

Step 19 In the <account name> Properties dialog box, select the IMAP tab.

Step 20 Uncheck the Store Special Folders check box.

Step 21 In the Root Folder Path field, enter INBOX (all upper-case letters).

Step 22 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook Express and Connection, skip to Step 25.
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Caution If you do not configure Outlook Express to use SSL, the Connection username and password 
that are sent to Connection over the network and the voice messages sent back from 
Connection are not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook Express and 
Connection, continue with Step 23.

Step 23 Select the Advanced tab.

Step 24 Under Incoming Mail, check the This Server Requires a Secure Connection (SSL) check box.

Step 25 Select OK to close the <account name> Properties dialog box.

Step 26 Select Close to close the Internet Accounts dialog box.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Novell GroupWise

To use GroupWise to access Cisco Unity Connection voice messages, create and configure a new 
GroupWise account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in GroupWise

Step 1 Start GroupWise.

Step 2 On the GroupWise Tools menu, select Accounts > Account Options.

Step 3 In the Accounts dialog box, select Add.

Step 4 In the Create Account dialog box, in the Account Name field, enter a name for the account. This name 
appears only in GroupWise.

Step 5 In the Account Type list, select IMAP4.

Step 6 Select Next.

Step 7 In the Create Internet Account dialog box, in the Incoming Mail Server (IMAP4) field, enter the IP 
address or the fully qualified domain name of the Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 In the Login Name field, enter the Connection username.

Step 9 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.
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Step 10 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 11 In the From Name field, enter the username.

Step 12 Select Next.

Step 13 Follow the on-screen prompts to complete the configuration.

Step 14 If you do not want to encrypt voice messages and other data that are sent over the network between 
GroupWise and Connection, skip to Step 20.

Caution If you do not configure GroupWise to use SSL, the Connection username and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

If you want to encrypt voice messages and other data that are sent between GroupWise and Connection, 
continue with Step 15.

Step 15 In the Accounts dialog box, select the name of the account that you just created.

Step 16 Select Properties.

Step 17 Select the Advanced tab.

Step 18 Under Incoming Mail Server (IMAP4), check the Use SSL check box.

Step 19 Select OK to close the <Account Name> Properties dialog box.

Step 20 Select Close to close the Accounts dialog box.

Step 21 Create the inbox for the new account, and download Connection voice messages:

a. In the left pane of GroupWise, select the name of the new account.

b. In the Logon to <AccountName> dialog box, enter the Cisco PCA password for the user.

c. Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
GroupWise does not prompt the user to enter the Connection password. The result is that users do 
not receive voice messages from Connection.

d. Select OK to close the Logon to <AccountName> dialog box.

e. With the name of the new account still selected in the left pane, on the GroupWise Tools menu, select 
Send/Receive > This Folder.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Opera

To use Opera to access Cisco Unity Connection voice messages, create and configure a new Opera 
account for the user. You need the following information:

• Connection username (alias).
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• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Opera

Step 1 Start Opera.

Step 2 On the Opera Tools menu, select Mail and Chat Accounts.

Step 3 In the Manage Accounts dialog box, select New.

Step 4 In the New Account wizard, select IMAP.

Step 5 Select Next.

Step 6 In the Real Name field, enter the account name.

Step 7 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Organization field, enter the applicable value.

Step 9 Select Next.

Step 10 In the Login Name field, enter the Connection username.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 Select Next. 

Step 13 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 If you want to encrypt voice messages and other data that are sent between Opera and Connection, check 
the Use Secure Connection (TLS) check box. (TLS is an updated version of SSL.)

Caution If you do not configure Opera to use SSL, the Connection username and password that are sent 
to Connection over the network and the voice messages sent back from Connection are not 
encrypted.

Step 15 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Step 16 Select Finish.

Step 17 Select OK to close the Subscribe IMAP Folders dialog box.

Step 18 Select OK to close the Manage Accounts dialog box.
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Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Thunderbird

To use Thunderbird to access Cisco Unity Connection voice messages, create and configure a new 
Thunderbird account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Thunderbird

Step 1 Start Thunderbird.

Step 2 On the Thunderbird File menu, select New > Account.

Step 3 In the Account wizard, on the New Account Setup page, select E-Mail Account.

Step 4 Select Next.

Step 5 On the Identity page, in the Your Name field, enter the username.

Step 6 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 7 Select Next.

Step 8 On the Server Information page, under Select the Type of Incoming Server You Are Using, select IMAP.

Step 9 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 Select Next.

Step 11 On the User Names page, enter the Connection username.

Step 12 Select Next.

Step 13 On the Account Name page, enter a name for the account. This name appears only in Thunderbird.

Step 14 Select Next.

Step 15 On the Congratulations page, confirm that the settings are correct, then select Finish.

Step 16 If you do not want to encrypt voice messages and other data that are sent over the network between 
Thunderbird and Connection, you are finished creating and configuring a new account. 

If you want to encrypt voice messages and other data that are sent between Thunderbird and Connection, 
continue with Step 17.

Step 17 In the left pane of Thunderbird, select the name of the account that you just created.

Step 18 In the right pane of Thunderbird, under Accounts, select View Settings for This Account.
3-16
User Workstation Setup Guide for Cisco Unity Connection Release 8.x

OL-21539-01



Chapter 3      Configuring an Email Account to Access Cisco Unity Connection 8.x Voice Messages
  Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Windows Mail for Windows Vista
Step 19 In the Account Settings dialog box, under the account that you just created, select Server Settings.

Step 20 Under Server Settings, select the Use Secure Connection (SSL) check box.

Caution If you do not configure Thunderbird to use SSL, the Connection username and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

Step 21 Select OK to close the Account Settings dialog box.

Creating and Configuring an Account to Access Cisco Unity 
Connection 8.x in Windows Mail for Windows Vista

To use Windows Mail for Windows Vista to access Cisco Unity Connection voice messages, create and 
configure a new Windows Mail account for the user. You need the following information:

• Connection username (alias).

• Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

• The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Windows Mail

Step 1 Start Windows Mail.

Step 2 On the Tools menu, select Accounts.

Step 3 In the Internet Accounts dialog box, select Add.

Step 4 On the Select Account Type page, select E-Mail Account.

Step 5 Select Next.

Step 6 On the Your Name page, in the Display Name field, enter the username.

Step 7 Select Next.

Step 8 On the Internet E-Mail Address page, in the E-Mail Address field, enter the Connection SMTP Address 
of the user and the name of the Connection server. You can find this information in the SMTP Address 
field on the User Basics page in Cisco Unity Connection Administration. The E-Mail Address typically 
follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Select Next.

Step 10 On the Set Up E-Mail Servers page, under Incoming E-Mail Server Type, select IMAP.

Step 11 In the Incoming Mail (POP3 or IMAP) Server field, enter the IP address or the fully qualified domain 
name of the Connection server.

Caution In Step 11 and Step 12, do not use the fully qualified domain name of the Connection server 
unless DNS is configured for the network.
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Step 12 In the Outgoing E-Mail Server (SMTP) Name field, enter the IP address or the fully qualified domain 
name of the Connection server.

Step 13 If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to 
Step 15.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses, 
continue with Step 14.

Step 14 Check the Outgoing Server Requires Authentication check box.

Step 15 Select Next.

Step 16 On the Internet Mail Logon page, enter the user Connection alias and Cisco PCA password.

Step 17 Select Next.

Step 18 On the Congratulations page, select Finish.

Step 19 Select Close to close the Internet Accounts dialog box.

Step 20 If you do not want to encrypt voice messages and other data that are sent over the network between 
Windows Mail and Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Windows Mail and 
Connection, continue with Step 21.

Step 21 On the Tools menu, select Accounts.

Step 22 In the Internet Accounts dialog box, select the name of the mail account that you just created and select 
Properties.

Step 23 In the Properties dialog box, select the Advanced tab.

Step 24 Under both the Outgoing Mail field and the Incoming Mail field, check the This Server Requires a 
Secure Connection (SSL) check box.

Step 25 Select OK.

Caution If you do not configure Windows Mail to use SSL, the Connection username (alias) and 
password that are sent to Connection over the network and the voice messages sent back from 
Connection are not encrypted.

Step 26 Select Close to close the Internet Accounts dialog box.

Troubleshooting IMAP Client Sign-In Problems in Cisco Unity 
Connection 8.x

When users change their Cisco PCA password (also known as the web-application password) in the 
Cisco Unity Connection Messaging Assistant, they also must update the password in their IMAP client 
application so that the client can continue to access Connection and retrieve voice messages.

If users have trouble receiving voice messages in an IMAP client, consider the following possibilities:

• If the IMAP client application prompts a user for the Cisco PCA password, but does not accept it, 
the Cisco PCA password may have expired or changed, or is locked. Users can change their 
password in the Connection Messaging Assistant first and then update it from their IMAP client 
application.
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• If Microsoft Outlook users are not prompted for their Cisco PCA password, verify that the 
Remember Password check box on the Internet E-mail Settings (IMAP) page is not checked. If this 
option is checked, and the password of the user has expired, changed, or is locked, Microsoft 
Outlook does not prompt the user to enter the Cisco PCA password. The result is that the user does 
not receive voice messages from Connection, and Outlook prompts for the username and password.
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